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Welcome to InTouch Runtime

Welcome to Wonderware  InTouch , the quickest and easiest way to create human-
machine interface (HMI) applications for the Microsoft  Windows   operating systems.
InTouch is a component of the Wonderware FactorySuite . The InTouch software
consists of two major programs, WindowMaker and WindowViewer. It also includes
several utility/diagnostic programs.

WindowMaker is the development environment, where object-oriented graphics are
used to create animated, touch-sensitive display windows. These display windows can
be connected to industrial I/O systems and other Microsoft Windows applications.
WindowViewer is the runtime environment used to display the graphic windows created
in WindowMaker.

To get started quickly, read this chapter for details on how to install and start-up your
InTouch system.

Contents
n InTouch Applications
n Special InTouch Runtime Features
n System Requirements
n Installing InTouch
n Running InTouch for the First Time
n About this Manual
n Technical Support
n Your FactorySuite License
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InTouch Applications
By using InTouch, you can create powerful, full-featured applications that exploit the
key features of Microsoft Windows, including ActiveX controls, Object Linking and
Embedding (OLE), graphics, and more. InTouch can also be extended by adding custom
ActiveX controls, wizards, generic objects, and creating InTouch QuickScript
extensions.

InTouch applications span the globe in a multitude of vertical markets including food
processing, semiconductors, oil and gas, automotive, chemical, pharmaceutical, pulp and
paper, transportation, utilities, and more.

Special InTouch Runtime Features
InTouch includes the following features:

• Applications Run on Windows NT Operating System or Windows 95
 InTouch allows you to create applications in Windows 95 and then run these

applications on the Windows NT operating system and vice versa. No conversion is
required for these applications. They are interchangeable and will run on either
platform.

• OCX Container
 InTouch supports OCX controls, ActiveX controls and Object Linking and

Embedding (OLE). You can easily select and add OCX or ActiveX controls to any
application window and to your toolbar. You can handle control events, call control
methods and set and get control properties all from InTouch QuickScripts. You can
also attach the OCX or ActiveX control properties directly to InTouch tagnames.

• 60,000 Tagname Support
 The InTouch Tagname Dictionary supports up to 60,000 tags. The number of

tagnames supported is dependent on the license you purchase.

• Remote Tagname Referencing
 Remote tagnames referencing allow you to access data from an I/O Server without

having to create the tagname in your local Tagname Dictionary. Remote tagnames
include data defined from most I/O data sources, for example Microsoft Excel and a
remote View node. When you import a window, you can quickly convert its
placeholder tagnames to remote tagnames to create entire client applications with
no local Tagname Dictionary.

• Asynchronous QuickFunctions
 QuickFunctions can be configured as asynchronous. The asynchronous functionality

is divided between the development environment of WindowMaker and the runtime
environment of WindowViewer. When executed, QuickFunctions immediately run
in the background at the same time that the main WindowViewer process is
running. This allows WindowViewer to separate time consuming operations such as
SQL database calls and "FOR NEXT" loops from the main program flow. When
such time consuming operations are performed through asynchronous
QuickFunctions, all animation links and other InTouch functionality simultaneously
remain active.
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• View as an NT Service
 WindowViewer can now run as an NT service. This provides NT service

capabilities for key InTouch components such as historical logging, providing
alarms and providing I/O data. The service capabilities allow continuous operation
of WindowViewer through operating system log-ins, log-outs, for example,
operator shift changes. Another functionality is automatic start up of InTouch
following power failure or, when the machine is turned off and on. This provides
unmanned station startup of WindowViewer without compromising NT operating
system security.

• Distributed Alarm System
The new distributed system supports multiple alarm servers or "providers"
concurrently, giving operators the ability to simultaneously view and acknowledge
alarm information from multiple remote locations.

• Distributed History
The distributed historical trending system allows you to dynamically specify a
different historical file data source for each pen of a trend chart. This allows an
operator to also view both native InTouch history and IndustrialSQL history in the
same trend.

• Dynamic Resolution Conversion
You can now develop applications in one screen resolution and run them at another,
without affecting the original application. The applications can also be run at a user-
defined resolution, instead of the display resolution.

• Dynamic Reference Addressing
Data source references can be changed to dynamically address multiple data sources
with a single tagname.

• Network Application Development
New remote development features accommodate large, multi-node installations,
including updating of all nodes on a network from a single development station.

• FactoryFocus
FactoryFocus is a view only Runtime version of InTouch 5.6 or later. It allows
Managers and Supervisors the ability to view a continuous HMI application process
in real time. System security is increased with the view only capability since no data
can be changed. No changes are needed to InTouch applications to use InTouch
FactoryFocus.

InTouch FactoryFocus functions as a client only. No data can be written from it
using DDE, FastDDE or Poked to programs such as Excel. Alarms can be viewed
but not acknowledged. Features such as animation links, tagnames, real-time and
historical trends are view only.

• Other InTouch features and benefits include:
−  Connectivity with more than 300 I/O Servers.
−  Low cost process viewer solution at a price significantly less than a full HMI.
−  VTQ (data Value, with associated Timestamp and Quality) of I/O type

tagnames provided by an I/O Server.
−  Wonderware SuiteLink protocol. SuiteLink allows application commands

(reads, writes and updates) and their associated data to be passed between
client applications and server applications.

−  Easily networked with Wonderware NetDDE.
−  Real-time application process viewing.
−  Standard Windows 95/NT GUI format featured.
−  Windows 95 and Windows NT operating systems long filename support.
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System Requirements
To run InTouch, we recommend the following hardware and software:

• Any IBM  compatible PC with a Pentium 100Mhz processor or higher.

• At least 100MB of free hard disk space.

• At least 32MB of random-access memory (RAM).

Note  We recommend 5MB of RAM per 5K tagnames. For example, 32MB of
RAM for 32K tagname support and 128MB of RAM for 60K tagname support.

• SVGA display adapter (2MB RAM recommended).

• Pointing device. For example, mouse, trackball, touch screen.

• Microsoft  Windows  95 or Windows NT  operating systems.

• For the Windows 95 operating system to implement the distributed functionality of
InTouch, Wonderware NetDDE must be installed and operational.

Note  Beginning with Wonderware FactorySuite InTouch Version 7.0, InTouch no
longer supports the Microsoft Windows 3.x or Microsoft Windows for Workgroups
operating systems.

Installing InTouch
The Wonderware FactorySuite installation program is used to install InTouch. InTouch
runs on Microsoft Windows  95 or Windows NT operating systems. The installation
program creates directories as needed, copies files from the distribution compact disk to
your hard drive, and adds the InTouch for Windows program to your Windows
Programs menu. When you point to InTouch for Windows, a submenu appears listing
all of the components of InTouch. For example, WindowMaker and WindowViewer.

&  For complete installation instructions, refer to your FactorySuite installation booklet
or your online FactorySuite System Administrator's Guide.
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Running InTouch for the First Time
The first time you run INTOUCH.EXE, the INTOUCH.INI file is automatically created. This
file contains the default configuration settings for your application. As you configure
your application, your settings are written to the INTOUCH.INI file.

Once you have customized your application, when you create a new application, you can
copy your customized INTOUCH.INI file to your new application's directory. This
eliminates the need for you to reset your customized parameters each time you create a
new application.

&  For more information on customizing your application, see your online InTouch
User's Guide.

Ø To run InTouch for the first time:

1. Start the InTouch program (INTOUCH.EXE).The Welcome to InTouch Application
Manager dialog box will appear.

2. Click Next. A second Welcome to InTouch Application Manager dialog box will
appear displaying the default path for the starting directory. For example,
C:\ProgramFiles\FactorySuite\InTouch\.

3. To specify a different directory, type the path to the directory in the input box, or
click Browse to locate the directory.

4. Click Finish.

5. The InTouch - Application Manager will appear and automatically search your
computer for any current InTouch applications. If an application(s) is found, an icon
with the application's name will appear in the dialog box. For example:
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Ø   To create a new application:

1. On the File menu, click New, or click the New tool in the toolbar. The Create New
Application wizard will appear.

2. Click Next. A second Create New Application wizard will appear.

8 By default, the system will display the path to your InTouch directory followed
by "NewApp."

3. In the input box, type the path to the directory in which you want your application
to be created or click Browse to locate the directory.

4. Click Next.

8 If the directory you specify does not exist, a message dialog box will appear
asking if you want to create it. Click OK. A third Create New Application
wizard dialog box will appear.

5. In the Name box, type a unique name for the new application's icon that appears
when the application is listed in the InTouch Application Manager window.

6. In the Description box, type a description of the application.

8 The description is optional. However, if you do type a description, it can be a
total of 255 characters.

7. Click Finish. The InTouch - Application Manager will reappear displaying an
icon with the name you specified for the new application. For example:

 
8. To open an application, click the right mouse button as you select it, and then click

the name of the program you want to use for the application in the File menu, or
select the application in the list, and then click the WindowMaker tool in the
toolbar. (WindowViewer cannot be executed for a new application.)

8 To quickly open the application, double-click it's icon or select it, and then
press ENTER.
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InTouch Application Manager
You will use the InTouch Application Manager to create new applications, open existing
applications in either WindowMaker or WindowViewer, delete applications, and run the
InTouch DBDump and DBLoad Tagname Dictionary utility programs.

	 For more information on the DBDump and DBLoad programs, see your online
InTouch User's Guide.

¾¾ To run the InTouch Application Manager:

1. Start the InTouch program (INTOUCH.EXE). The InTouch Application Manager
dialog box appears:

 

� When you select an application in the list, it's name and it's description will appear
in the box at the bottom of the screen. You can edit the description. If you right-
click the description box, a menu appears displaying the commands that you can
apply to the selected text.

You can also execute several of the InTouch Application Manager's menu
commands from the menu that appears when you click the right mouse button as
you select an application. For example:

 

2. To rename an application's icon, right-click the application in the list, and then click
Rename. Type the new name and press ENTER.

3. To delete an application's icon, right-click the application in the list, and then click
Delete. A message box will appear asking you to confirm the deletion. Click Yes to
delete the application from the window or click No to cancel the deletion.

� If you delete an application from the list, it does not delete your files or
directory. If you need to display it later, on the Tools menu, click Find. The
Starting directory for search dialog box appears:
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Locate the directory in which you want to search for applications, and then
click OK . The InTouch Application Manager will reappear displaying icons for
all applications that were found in the selected directory.

� If you right-click in the window, a menu will appear displaying the
commands that you can apply to a selected item.

The Application Manager's Tools
By default when InTouch is initially run, the Application Manager's toolbar and status
bar are displayed.

¾¾ To hide the toolbar:

On the View menu, select Toolbar. To show it again, repeat this step.

¾¾ To hide the status bar:

On the View menu select Status Bar. To show it again, repeat this step.

The following briefly describes each of the Application Manager's toolbar buttons:

Button Description

Executes the New command on the File menu  to create a new
application.

Executes the WindowMaker  command on the File menu to
open the selected application in WindowMaker.

� To quickly open an application in WindowMaker, double-
click it's icon or select it, and then press ENTER.)

Executes the WindowViewer command on the File menu to
open the selected application in WindowViewer.

Executes the DBLoad command on the File menu to run the
DBLoad utility used to load a Tagname Dictionary input file.

Executes the DBDump command on the File menu to run the
DBDump utility program used to extract an application's
Tagname Dictionary.

	 For more information on the DBDump and DBLoad
programs, see your online InTouch User's Guide.
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Executes the Large Icons command on the View menu to
display large icons for the listed applications.

Executes the Small Icons command on the View menu to
display small icons for the listed applications.

Executes the List command on the View menu to change the
dialog box to the list view mode. For example:

 
Executes the Details command on the View menu to change
the dialog box to the details view mode. For example:

 
8 If you right-click any of the column headers, or click a blank area of the window, or

click a detail (other than the application name) the following menu appears:
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 If you point to View, the following submenu appears:

 

 These commands are also found on the View menu. They control the display list in
the InTouch Application Manager.

Opens the Node Configuration dialog box that you will
use to set the computer's properties when you are using
Network Application Development (NAD), Dynamic
Resolution Conversion (DRC) and/or distributed
alarming.

&  For more information on NAD and DRC see your online
InTouch User's Guide.

$  For more information on distributed alarms, see Chapter 3,
"Alarms/Events."
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Note  When an application is selected in the Application Manager display list, selecting
the Properties command on the File menu will cause the Properties dialog box for that
application to appear:
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About this Manual
This manual describes the various aspects of using InTouch in the runtime environment
(WindowViewer). It is written in a "procedural" format that tells you in numbered steps
how to perform most functions or tasks.

$  If you are viewing this manual online, when you see a cross reference like this one,
it is actually a "hot link" to the referenced section or chapter. Click it to "jump" to
that section or chapter. When you jump to another section or chapter and you want
to come back to the original section, a "back" option is provided.

&  These types of cross references indicate that you need to look in another
FactorySuite book for more information.

8 These are "tips" that tell you an easier or quicker way to accomplish a function or
task.

To familiarize yourself with the WindowMaker development environment and its tools,
read Chapter 1, "WindowMaker Program Elements." To learn about working with
windows, graphic objects, wizards, ActiveX controls and so on, read Chapter 2, "Using
WindowMaker."

In addition, the InTouch Reference Guide provides you with an in-depth reference to the
InTouch QuickScript language and functions, system tagnames, and tagname .fields.

The FactorySuite Systems Administrator's Guide also provides you with complete
information on the common components in the FactorySuite, system requirements,
networking considerations, product integration, technical support, and so on.

For details on the add-on program, SPC Pro, see your SPC Pro User's Guide.

For details on the add-on program, Recipe Manager, see your Recipe Managers User's
Guide.

For details on the add-on program, SQLAccess Manager, see your SQL Access Manager
User's Guide.

8 Online documentation is included in your FactorySuite software package for all
FactorySuite components included in your package. For example, FactorySuite
System Administrator's Guide, SPC Pro, SQLAccess Manager, Recipe Manager,
IndustrialSQL Sever, InControl and all Wonderware 32-bit I/O Servers. If you
purchase FactorySuite+ you also get the online documentation for the InTrack and
InBatch components.

Assumptions
This manual assumes you are:

• Familiar with the Windows 95 and/or Windows NT operating system working
environment.

• Knowledgeable of how to use of a mouse, Windows menus, select options, and
accessing online Help.

• Experienced with a programming or macro language. For best results, you should
have an understanding of programming concepts such as variables, statements,
functions and methods.



Welcome to InTouch xvii

Technical Support
Wonderware Technical Support offers a variety of support options to answer any
questions on Wonderware products and their implementation.

Prior to contacting technical support, please refer to the relevant chapter(s) in your
InTouch User's Guide for a possible solution to any problem you may have with your
InTouch system. If you find it necessary to contact technical support for assistance,
please have the following information available:

1. Your software serial number.

2. The version of InTouch you are running.

3. The type and version of the operating system you are using. For example, Microsoft
Windows NT Version 4.0 workstation.

4. The exact wording of system error messages encountered.

5. Any relevant output listing from the Wonderware Logger, the Microsoft Diagnostic
utility (MSD), or any other diagnostic applications.

6. Details of the attempts you made to solve the problem(s) and your results.

7. Details of how to recreate the problem.

8. If known, the Wonderware Technical Support case number assigned to your
problem (if this is an on-going problem).

&  For more information on Technical Support, see your online FactorySuite System
Administrator's Guide.

Your FactorySuite License
Your FactorySuite system license information can be viewed through the license
viewing utility that is launched from the WindowMaker Help About dialog box.

8 To access the About dialog box, select the About command on the WindowMaker
Help menu.

&  For more information on the licensing viewing utility, see your FactorySuite System
Administrator's Guide.
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C H A P T E R  1

Using WindowViewer

WindowViewer is the InTouch runtime environment where the object-oriented graphics
that were created and animated in WindowMaker are monitored and controlled. These
graphic objects may be connected to industrial I/O systems and other Microsoft
Windows applications.

This chapter describes the WindowViewer commands that you will use to perform
various functions or tasks during runtime. If you are new to InTouch, you should read
through this chapter completely to familiarize yourself with the WindowViewer
commands and functions.

Contents
n Working with WindowViewer Windows
n Application Security
n System Diagnostics
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Working with WindowViewer Windows
Your InTouch application will more than likely be comprised of numerous windows that
display the graphics and text objects created in WindowMaker.

This section describes the procedures that you will follow to open and close the
windows contained in your InTouch application.

Common Dialog Box Features
When you are opening or closing a window(s), the dialog boxes that you will use are
very similar and have many common features. To avoid redundancy in the procedures
describing how you perform these actions, the common features of those dialog boxes
are described in this section.

When you click either the Open Window or Close Window command on the File
menu, by default, the respective dialog box for the command you selected will appear in
the "list view." Meaning that the names of all the windows that are applicable for the
selected command will appear in a continuous list. For example:

 

Note  A horizontal scroll bar will appear when the number of window names exceeds
the default list space.

Click Details to change from the "list view" to the details view.

When you select the details view, the windows and their details are displayed in a multi-
column format. The details displayed include any comments regarding the window that
the application developer entered when the window was created, the window's type, the
date and time it was last modified. For example:
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Note  In the details view, you can select any unopened window by clicking on any
portion of its row, not just the check box. (The entire row will be highlighted.) You can
click on a selected window a second time, to deselect it.

A vertical scroll bar will also appear when the number of window names exceeds the
default list space.

To sort the list by a detail type, click the column header for that detail. The details view
sort sequences:
• Name - Alphabetically
• Comments - Alphabetically
• Type - Overlay, Replace then Popup
• Last Modified - From oldest date/time (top) to most recent (bottom)

8 Each time you click a column header, the list sort order will toggle from ascending
to descending. For example, if the list is currently sorting in ascending order and
you click a column header, the list will be resorted in descending order for the
column selected.

To return the list to the default display, click the small box on the far left side of the
column header.

To size the columns, place the cursor over the vertical lines that separate each detail
header. When the cursor changes to an "I" bar, click and drag the header to the width
you want for the column.

8 To quickly auto-size a column, double-click on the column's right vertical line
separator.

To open selected window(s) click OK.
To cancel your selections and close the dialog box, click Cancel.
To return the dialog box to "list view," click List.
To select all listed windows, click Select All.
To clear all selected windows, click Clear All.
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Opening Windows
Ø To open windows:

1. On the File menu, click Open Window. The Windows to Show dialog box will
appear.

2. Click the check box next to the name of the window(s) that you want to open.

8 By default, all currently opened windows will already be checked.

3. Click OK to close the dialog box and open the selected window(s).

Note  If a "Replace" type window is selected, it will cause any windows that it
intersects to close.

&  For more information on window types, see your online InTouch User's Guide.

Closing Windows
Ø To close open windows:

1. On the File menu, click Close Window. The Windows to Hide dialog box will
appear.

2. Click the check box next to the name of the window(s) that you want to close.

3. Click OK to close the dialog box and close the selected window(s).

Transferring to WindowMaker
Ø To transfer from the WindowViewer program to the WindowMaker program:

1. On the File menu, click WindowMaker. The Windows to Edit dialog box will
appear.

8 To quickly transfer to WindowMaker, click the Development fast switch in the
upper right hand corner of the menu bar (or use the short cut keys ALT + !).
When you transfer using the fast switch, the Windows to Edit dialog box does
not appear in WindowViewer. The windows that are open in WindowViewer
when you transfer to WindowMaker will remain open.

Note  The fast switch will only be available if, during development, the
application developer configured the application to use it.

2. Click the check box next to the name of the window(s) that you want to be open
when you transfer to WindowMaker.

3. Click OK to close the dialog box and transfer to WindowMaker.

Note  If the application developer selected the Close WindowViewer option when
WindowViewer's properties were configured during development, WindowViewer will
automatically close when you transfer to WindowMaker.
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Executing InTouch QuickScripts
By default, when WindowViewer is initially started, the logic for all scripts will be
executing.

Ø To stop all QuickScripts from executing:

1. On the Logic menu, click Halt Logic. The Windows to Edit dialog box will
appear.

Note  During development, if the application developer selected the Allow CTRL-
Break to stop scripts option when WindowViewer was configured, you will not be
able to stop the QuickScripts from executing regardless of whether the Logic menu
is displayed or not.

Also, the Halt Logic command will not stop any currently executing asynchronous
QuickFunctions. But, it will prevent any new asynchronous QuickFunctions from
executing.

&  For more information on the above items, see your online InTouch User's
Guide.

Initializing I/O Conversations
When WindowViewer is started, it automatically processes an initiate request to start all
I/O conversations. If an I/O Server program does not respond to WindowViewer's
initiate request, you can force WindowViewer to try again to establish the I/O
conversation.

Ø To start all uninitiated I/O conversations:

On the Special menu, click Start Uninitiated Conversations.

8 Executing this command will not affect existing conversations.

Ø To restart all I/O conversations:

On the Special menu, click Start Uninitiated Conversations.

8 This command closes all existing I/O conversations and restarts the entire process
of setting up I/O conversations. All I/O points are affected by this command.
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Application Security
Applying security to an application is optional. However, if implemented, it provides the
application developer with the ability to control whether or not specific operators are
allowed to perform specific functions within an application. Additionally, when security
is implemented, audit trails can be created that tie the operator to all alarms/events that
occurred during the time he was logged on to the system.

Security is based on the concept of the operator "logging on" to the application and
entering his "User Name" and "Password." (The application developer defines a "User
Name," "Password" and, an "Access Level" for each operator during development.)

When a new application is created, the default "User Name" is "Administrator" with an
access level of 9999. (The access level, 9999, grants access to all security commands).
Once a new user name is added to the security list and WindowMaker or
WindowViewer is restarted, the default user name is automatically reset to "None" with
an access level of zero (0). (An access level of zero prevents access to the Configure
Users menu command in both WindowMaker and WindowViewer). Therefore, in order
to access the security user list, a user name must be configured for the System
Administrator with an access level equal to or greater than 9000.

Once an operator logs on to the application, access to any protected function is granted
upon verification of his "Password" and "Access Level." (These are verified against the
value specified for the internal security tagname linked to the function.) For example,
access to a window, or visibility of an object, pushbutton, and so on, can be controlled
by specifying that the logged on operator's "Access Level" must be greater than 2000.

Note  Typically to "Log on" to an application, on the Special menu, the operator points
to Security then, clicks Log On submenu. However, the application developer can also
design a custom log-on window that contains a touch-sensitive input objects that are
linked to internal security tagnames that the operator uses to enter his "User Name" and
"Password" values.

Logging on to Your Application
Ø To "log on" to your application:

1. On the Special menu, point to Security then, on the submenu, click Log On. The
Log On dialog box appears:

 
2. In the Name box, type your user name.

3. In the Password box, type your password.

4. Click OK.

8 If the information is entered incorrectly or is invalid, a message box indicating
that log on failed will appear.

If log on is successful, the $AccessLevel internal tagname will be set to its
predefined value (configured in the security user list).
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Changing Your Security Password
Ø To change your password:

1. On the Special menu, point to Security then, click Change Password on the
submenu. The Change Password dialog box appears:

 
2. In the Old Password field, type the old password.

3. In the New Password field, type the new password (up to 32 characters).

4. In the Verify Password field, type the new password again.

5. Click OK.

8 To prevent anyone who may be watching the operator from seeing the
password, the information entered is displayed on the screen as asterisks.

Note  If you do not plan on displaying the Special menu in WindowViewer, you
can create a discrete button and link it to the $ChangePassword internal tagname
to set the $ChangePassword tagname equal to 1 to cause the Change Password
dialog box to be displayed. Once displayed, the operator can change his/her
password.

Configuring an Operator's Security Level
Ø To configure security for the operators of your application:

1. On the Special menu, point to Security then, click Configure Users on the
submenu. The Configure Users dialog box appears:

 
2. In the User Name field, type the name that you want to assign to the operator.

3. In the Password field, type a password (up to 32 characters).

4. In the Access Level field, type a value (lowest = 0 to highest = 9999).

5. Click Add to add the user name to the security list.
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8 To modify an existing user name, select the desired name in the User Name
list. Type the changes then click Update to accept the changes. To delete a user
name, select it in the list, then click Delete.

Note  The None and Administrator names are reserved and only the password
(Wonderware) or Administrator may be changed. Once you have configured user
names for your application, you should change the Administrator name's password
since it will more than likely become commonly known to most users of the system. The
Administrator default access level (9999) is the highest and allows access to everything
including, the Configure Users menu command.

Logging Off Your Application
Ø To log off your application:

On the Special menu, point to Security then, click Log Off on the submenu.

8 When this command is executed, the "User Name" is reset to "None" with an
Access Level of "0".

Note  The application developer may have configured the application to
automatically log off an operator after a specified amount of time has elapsed with
no activity. If this is the case, to prevent yourself from being automatically logged
off, you must either press a key or click the mouse prior to the specified timeout.
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System Diagnostics
By default, the Wonderware Logger program is started automatically with most InTouch
products and supported I/O Servers.) The Wonderware Logger displays and logs system
and error information to disk such as, the date and time the logger was started and
closed, the version of the software you are running, the type of CPU being used, the
Windows mode, available free memory, and so on.

Ø To view the error log:

On the Special menu, click View Error/Information Log. The Wonderware Logger
appears:

 

Note  When running any Wonderware software product, we recommend that you always
run the Wonderware Logger in the background. If a problem occurs with an application,
I/O Server, and so on., always check the Wonderware Logger for error messages prior to
calling Technical Support.

&  For more information on the Wonderware Logger, see your online FactorySuite
System Administrator's Guide.
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Historical Trending

InTouch historical trending capabilities are extensive. Up to eight database entries can
be trended at one time with no limit to the number of trends displayed at one time. This
chapter covers configuring trends, printing trends and controlling historical logging.

Contents
n Configuring a Historical Trend During Runtime
n Restarting Historical Logging
n Stopping Historical Logging
n Distributed History
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Configuring a Historical Trend During Runtime
During development, if the application developer selected the Allow runtime changes
option when WindowMaker was configured, the historical trend will be "touch-
sensitive" in WindowViewer. This means that you can click the trend (or touch it if
using a touch screen) to access the dialog box that allows you to change the pen
assignments, change the start date and time, and so on.

Ø To configure a historical trend:

1. Click the trend. The Historical Trend Setup dialog box appears:

 
2. In the Chart Start group, type the starting date and time for the chart.

3. Select the Display Mode for your chart. There are three modes as illustrated and
described in the examples below.

Note  The display mode of the chart affects performance. The primary factor here is
the length of the lines being drawn to generate the chart. The longer the lines, the
longer it takes to generate the chart. Line widths are also a performance factor; wide
lines take significantly longer to draw. Min/Max or Average/Scatter charts are
generally much faster to generate than Average/Bar Chart.

There are three modes as illustrated and described in the examples below.
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Min/Max Historical Trend Example
This mode displays the trends or changes in the percentage of Engineering Units scale as
a vertical line over the time span with emphasis on time flow and rate-of-change, rather
than amount of change.

Note  The blank area on the right side indicates that no data was collected during that
time period either because WindowViewer was not running or historical logging was
turned off.

Average/Scatter Historical Trend Example
This mode shows the average value of the point during the time intervals.

Average/Bar Chart Historical Trend Example
This mode shows the average value of the point during the time intervals in bar form.

4. In the Chart Length box, type the horizontal (x-axis) length of time to be displayed
on the trend, and then select the time increment for the length.

8 If you type a 1 and select Hrs, your trend will be 1 hour long.
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5. In the Chart Range boxes, type the percentage of Engineering Units scale that the
trend is to zoom in/out ( vertical (y-axis) range to be displayed on the trend).

8 The units for the range are a "percentage" of Engineering Units scale. These
values should be from 0 to 100. For example, if you want to trend the variance
of the selected tags from 40 to 45 percent of scale, enter 40 and 45 in the Min
and Max % range boxes respectively.

6. Click each Pen# to select the tagname that you want the pen to trend. The Tag
Browser appears in the filtered selection mode:

 
8 Only the tagnames that are defined with the Log Data option selected will be

displayed for the selected tag source.

7. Double-click the tagname that you want the selected pen to plot on the trend, or
select the tagname, and then click OK. The Historical Trend Setup dialog box
will reappear showing the selected tagname next to the Pen# button you originally
clicked.

8 You can click the Filter arrow to open the list of defined filters that you can
use to populate the Tag Browser. The first entry of this list is <none>, which
means that no filter is being used. Only the tagnames that are defined with the
Log Data option selected will be displayed for the selected tag source.

 When you use a filter or, click the Filter  button and create a new filter, the
Tag Browser will be repopulated with all tagnames defined with the Log Data
option that meeting the criteria specified in the filter for the selected tag source.

&  For more information on the Tag Browser and filters, your InTouch User's
Guide.
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8. Click Print to print the historical trend.

8 The printing operation takes place "in the background" while WindowViewer
continues to process all other inputs. WindowViewer will add two items to its
menu during printing:  CancelPrint and X % Done. Clicking on CancelPrint
will cancel the current print job.

After selecting Print, do not change the trend until the CancelPrint and X %
Done items disappear in the WindowViewer menu bar. During this time,
WindowViewer is saving the trend information in memory for printing. Once
these two items disappear in the menu bar, the trend can be changed without
affecting the print that is in progress.

Note  The printing operation uses the current historical trend as a basis for
printing. Therefore, if any field in the Historical Trend Setup dialog box is
changed, the Print button will not be active. Changes made in the setup cannot
be printed until you click OK in the Historical Trend Setup dialog box then,
access it again and select the Print button.
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Printing Performance
There are many factors that affect the performance of printing Historical Trends. The
primary performance factor is the size of the trend on the printed page. The display
mode of the trend also affects printing performance. Min/Max or Average/Scatter
printouts are usually generated much faster than Average/Bar Chart trends. The longer
and wider the lines on the trend are, the longer it takes to print.

Restarting Historical Logging
The system will automatically stop Historical Logging if there is no free disk space.
When this occurs, a message box appear informing you of the problem. To reactivate
disk logging, you must free up disk space then, restart historical logging.

Ø To restart historical disk logging:

On the Special menu, click Restart Historical Logging.

Stopping Historical Logging
Ø To stop historical disk logging:

On the Special menu, click Stop Historical Logging.

Distributed History
InTouch provides a distributed history system that allows retrieval of historical data
from any InTouch 5.6 (or later) application, even those across a network. This system
extends the capabilities of the standard InTouch history by allowing remote retrieval of
data from multiple historical databases simultaneously. These databases are referred to
as history providers. Up to eight history providers can be displayed simultaneously, one
for each historical trend chart pen.

Note  History providers can be configured as native InTouch history or IndustrialSQL
(InSQL) history providers.
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Alarms/Events

InTouch provides a notification system to inform operators of process and system
conditions. This system supports the displaying, logging, and printing of process alarms
and system events. Alarms represent warnings of process conditions, while events
represent normal system status messages.

InTouch includes two alarm systems: a standard system and a distributed system. The
standard system is used to display and acknowledge events and alarms generated by the
local InTouch application. The distributed system expands this scope to allow the
display and acknowledgment of alarms generated by alarm systems of other networked
InTouch applications.

Contents
n Alarms and Events
n Alarm Priorities
n Alarm Groups
n The Standard Alarm Display
n The Distributed Alarm System
n Alarm Logging
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Alarms and Events
InTouch has two types of notifications to inform operators of process activity:  Alarms
and Events. Alarms represent warnings of process conditions that could cause problems,
and require an operator response. A typical alarm is triggered when a process value
exceeds a user-defined limit, such as an analog value exceeding a hi-limit threshold.
This triggers an unacknowledged alarm state which can be used to notify the operator of
a problem. If configured to do so, InTouch can also log this alarm to a disk-based file
and print it out to a printer. Once the operator acknowledges the alarm, the system
returns to an acknowledged state.

Events represent normal system status messages, and do not require an operator
response. A typical event is triggered when a certain system condition takes place, such
as an operator logging into InTouch. If configured to do so, InTouch can log an event to
a disk-based file and print it out to a printer.

Alarm Types
InTouch classifies alarms into several general categories based on their characteristics.
These categories are known as Type and Class. The standard alarm system categorizes
all alarms into five general Types: Discrete, Deviation, Rate-of-Change, Value, and
SPC. The distributed alarm system provides further categorization of these alarms into
Class and Type. The table below summarizes the classification for both systems:

Standard Distributed Distributed
Alarm Condition Type Class Type

Discrete DISC DSC DSC
Deviation - Major LDEV DEV MAJDEV
Deviation - Minor SDEV DEV MINDEV
Rate-of-Change ROC ROC ROC
SPC SPC SPC SPC
Value - LoLo LOLO VALUE LOLO
Value - Low LO VALUE LO
Value - High HI VALUE HI
Value - HiHi HIHI VALUE HIHI

Event Types
InTouch also classifies events into general categories based on their characteristics.
These categories are known as Event Types. Both the standard and distributed alarm
systems use the same Event Types. The table below summarizes the classification for
both systems:

Event Condition
ACK Alarm was acknowledged
ALM Alarm has occurred
EVT An alarm event occurred
RTN Tagname returned from an alarm state to a normal state
SYS A system event occurred
USER $Operator changed

DDE The tagname value was poked from a DDE client
LGC A script modified the tagname value
OPR The operator modified the tagname value using the Value Input

The first six events listed are configured automatically when event logging is enabled.
The remaining three must be defined by the application developer during development..
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Alarm Priorities
Each alarm configured in InTouch has a priority value associated with it. This value
represents the severity of the alarm and can range from 1 to 999 with 1 being the most
severe.

For example, if a process plant has determined that they need four levels of severity,
they could establish ranges as shown below:

Alarm Severity Priority Range
Critical 0 - 249
Major 250 - 499
Minor 500 - 749
Advisory 750 - 999

As the plant engineers create InTouch tagnames and alarm conditions, each alarm will
be assigned to one of these severity levels by choosing a priority number within that
range. With these ranges configured, the plant operators may now easily display and
print only certain severity levels.

Alarm Groups
Each InTouch alarm is assigned to a logical Alarm Group. These groups are user-
definable and can be arranged into a hierarchy up to eight levels deep. The groups
provide a way of categorizing alarms based on an organization, plant layout, or any
other metric you choose. Alarm Groups are useful for filtering alarm displays, alarm
printers, and acknowledgment scripts.

Every tagname is associated with an Alarm Group. If the application developer does not
associate an Alarm Group name to a tagname, by default, InTouch automatically
associates it with the root group, $System. Any Alarm Group may have both tagnames
and other Alarm Group names associated with it. Alarm Groups are organized into a
hierarchical tree structure with the root group, $System, at the top of the tree. All
defined Alarm Groups automatically become descendants of the root group.

This tree may have up to eight levels. Each Alarm Group may have a maximum of 16
subgroups. Each subgroup may have a maximum of 16 subgroups, etc., until the
maximum of 8 levels is reached.

 
This illustration displays only Alarm Groups, not the tagnames within each group. This
tree concept is analogous to the MS-DOS directory structure, where a directory may
contain other sub-directories (analogous to groups) and file names (analogous to
tagnames).

The distributed alarm system also uses these groups as the basis for it’s Alarm Group
Lists.
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The Standard Alarm Display
The standard alarm system provides you with a unique display object that shows locally
generated alarms. While the distributed alarm system display object shows alarms
generated both locally and remotely. For example:

 
The standard alarm display uses two predefined display types:  "Alarm Summary" and
"Alarm History". The Alarm Summary only displays the current unacknowledged and
acknowledged alarms. If an alarm returns to normal (RTN), the entry is removed from
the display (if you have configured it to do so). No events are displayed with an Alarm
Summary. The Alarm History object displays all of the alarm and events that have
occurred. The Alarm History display shows the occurrence of the alarm, the time of
acknowledgment (if any) and the time the alarm condition returned to normal.

In both the Alarm Summary and the Alarm History display objects, each entry is shown
as a separate line. The number of entries displayed is determined by the size you have
drawn the object and the size of the font that you are using. The standard alarm display
lists all active alarms or subsets of active alarms as determined by the current value of
the Alarm Group and priority expression associated with the particular alarm display.

During development, the application developer configures how many alarms are stored
for the Alarm History object, the appearance of the alarm displays including, the
information that is displayed, logged and printed.

Remote Alarming Using the Standard Alarm System
The standard alarm system is primarily intended for single-node alarm monitoring.
However, the application developer can configure it to for the remote display and
acknowledgment of alarms from identical InTouch applications. These applications can
be configured so that a master or "Alarm Server" node can share its alarms with one or
more remote nodes. These alarms are displayed in real-time on the remote nodes as they
occur on the master node. Also, the alarms can be acknowledged remotely by tagname
or by Alarm Group. The only requirement is that each node has Wonderware NetDDE
running and each node must run identical InTouch Tagname Dictionarys.
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The Distributed Alarm System
InTouch provides two alarm systems: standard and distributed. Both provide services to
display, log, print, and acknowledge process alarms and system events. The standard
system is used to display and acknowledge events and alarms generated by the local
InTouch application. The distributed system expands this scope to allow the display and
acknowledgment of alarms generated by the local alarm systems of other InTouch
applications.

Both the standard and distributed systems can be used in a distributed application. The
major difference is that the standard system is limited to only those alarms generated by
an identical InTouch application, while the distributed system has no such limitation.

The distributed alarm system features include:

• The ability to display and acknowledge alarms from any InTouch node on a
network.

• A new alarm display that has built-in scroll bars, sizable display columns, multiple
alarm selections, an update status bar, dynamic display types, and display colors
based on alarm priority.

• Script functions that provide dynamic control over the alarm display and alarm
acknowledgment.

• A grouping mechanism that allows multiple Alarm Groups across different
applications to be called via a single name.

• The capability of adding comments to alarms when acknowledged.

The distributed alarm system can be thought of as an extension of the standard alarm
system. The standard alarm system provides local alarm display, printing, logging, and
acknowledgment of alarms. The distributed alarm system expands the scope of the
display and acknowledgment features to include alarms generated by remote
applications (alarm providers).

Since the distributed alarm system is an extension of the standard alarm system, it shares
many of the same configurations, all presented previously. The following sections
outline just those configurations that are specific to the distributed alarm system.

Alarm Group Lists
The distributed alarm system uses the same Alarm Group mechanism as the standard
alarm system. This mechanism groups alarms into a local hierarchical tree structure that
both the standard and the distributed alarm displays can use to filter alarms for display.
However, the distributed alarm system allows you to view these groups from multiple
nodes on a network. To provide a grouping for these node and Alarm Groups, the
distributed alarm system uses an Alarm Group List.

The Alarm Group List is a named list consisting of InTouch nodes and the Alarm
Groups defined on each of those nodes. It can also contain other Alarm Group List
Names as well as local Alarm Groups. This list is used by the distributed alarm display
to query for alarms.
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The Distributed Alarm Display
The distributed alarm system has a unique display object to show both locally and
remotely generated alarms. This display object's features include: built in scroll bars,
sizable display columns, multiple selection of alarms, update status bar, and alarm
display colors based on alarm priority.

InTouch allows you to modify the appearance of the alarm display (including the
information that is displayed), the colors used for various alarm conditions, and the
Alarm Group and alarm priority levels displayed.

 

Alarm Messages

Status Message Box Update Progress Bar

Horizontal
Scroll Bar

Alarm Message Title Bar

Vertical
Scroll Bar

Scroll Bars
The distributed alarm display has built-in horizontal and vertical scroll bars that allow
you to move through listed alarms. The application developer configures whether or not
scroll bars are displayed.

Sizable Display Columns
The distributed alarm display uses a grid to hold the alarm messages. This grid allows
for dynamic sizing of the column widths simply by selecting a column and dragging it to
set the column width. This functionality is available only during runtime. The
application developer configures whether or not the grid can be used to size the
columns.

8 Grid column changes are not saved; therefore, if you make grid column changes and
close the window containing the alarm display, the grid columns will again be at
their default width upon re-opening that window.

Multiple Selection
The grid allows you to select a single or multiple alarms in a list box. The application
developer configures the selection behavior to allow either toggle selection (item by
item), or multiple selection (holding down CTRL or SHIFT in conjunction with a mouse
click to select multiple alarms). The application developer can also turn off runtime
selection.

Alarm Message Colors
The application developer can configure up to eight different colors for each displayed
alarm message based on the priority of the alarm and whether it is acknowledged or not.
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Update Status Bar
The distributed alarm display includes a status bar that contains two indicators: A status
message and a progress bar. These indicators provide an overview of the current state of
the display query. The application developer can turn off the display of the status bar in
runtime.

Status Message Progress Bar

Feature Description

Status Message The status message at the left end of the status bar
provides a more detailed description of the current query
status.

Progress Bar The update progress bar at the right end of the status bar
provides a visual indication of the current query
progress.

State/Indicator Status Message Progress Bar

No Query None None
Query Incomplete Update Incomplete By Formula
Query Complete Update Successful Solid Blue

Displaying Alarm Statistics
The Distributed Alarm System provides a built-in alarm statistics dialog box. The
application developer can design the application to call up the Alarm Statistics dialog
box to list the status of the current query for a particular alarm display.

The Alarm Statistics dialog box provides you with an overview of the current alarm
query for a particular alarm display. It lists the actual alarm providers requests and the
results of each. It's important to note that even though you may have requested a single
Alarm Group List name, that name may equate to several individual Alarm Provider
queries. For example:

8 Each row in the dialog box lists a number and a query. The number represents the
percentage of that query that has been returned. The dialog box provides a static
display of the query results.

Ø To update the Percent of Alarms Retrieved in Query list:

1. Click Update.

2. Click OK to close the dialog box.
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Configuring a Node for Distributed Alarms
Most configurations for InTouch applications are defined in WindowMaker. These
configuration settings reside in the application and are copied to wherever the
application is copied.

However, in a distributed environment, certain settings may be unique to each View
node that runs an application. These settings are, therefore, configured at the View node
instead of in the application that is common to all nodes. The distributed alarm system,
provides two such settings: "Alarm Server" and "Alarm Provider." Both of these settings
are specific only to the behavior of a the View node and are not a part of the InTouch
application it is running.

Ø   To configure a node as an alarm server or alarm provider:

1. Start the InTouch program (INTOUCH.EXE). The InTouch - Application Manager
dialog box appears:

 
2. Click the Node Properties tool. The Node Configuration dialog box appears with

the App Development property sheet active.
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3. Click the Alarms tab to activate Alarms property sheet:

 
4. In the Distributed Alarms group select the options that you want to use as follows:

This node will display alarms - Sets the local node to display distributed alarms.

8 When you select this option, the node will start a background task called Alarm
Manager. This task will allow the node to connect to the distributed alarm
system. This setting must be set for the distributed alarm display to show any
alarms.

This node will provide alarms - Sets the local node to act as an alarm provider and
serve alarms to other nodes.

8 When you select this option, the node will start two background tasks called
Alarm Manager and Alarm. These tasks will allow the node to connect to the
distributed alarm system and provide alarms. This setting must be set for the
distributed alarm display to show local alarms.

4. Click OK.

Dynamically Controlling the Display Type
The distributed alarm display can show summaries of active alarms or listings of
historical alarms. Unlike the standard alarm display, which is configured during
development to either display summaries or historical alarms. The distributed alarm
display can show either, dynamically if the application developer has designed the
application to do so.

For example, the application developer can create an button that the operator clicks to
execute a script to set the alarm object's type to Summary to display the summaries of
current alarms. Conversely, the alarm object's type could be set to History to display
historical alarms.
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Alarm Logging
In addition to displaying and printing alarms, InTouch allows you to log alarms to the
computer's hard disk. The log file created is an ASCII file and can be read from most
text editors. The application developer configures various parameters such as when the
system will cycle filenames, how long the files will be stored and what information will
be logged.

The system will stop alarm logging whenever there is no free disk space. When this
occurs, a message box will appear informing you of the problem. To reactivate disk
logging, you must free up disk space then, restart alarm logging.

Ø To restart alarm disk logging:

On the Special menu, click Restart Alarm Log.
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Running Distributed Applications

InTouch is designed to support both stand-alone and distributed applications. Stand-
alone applications are those that use just one Operator Interface (OI) for each monitored
system, such as in a boiler package control. Conversely, distributed application are much
more complex, often with several layers of networks. Distributed applications, typically,
have a central development station, central data storage, and many client stations which
interact with the central station and each other.

InTouch provides many features that greatly ease the building and maintenance of
distributed applications. One of the most powerful is Network Application Development
(NAD). NAD allows many client stations to maintain a copy of a single application
without restricting the development of that application. InTouch NAD also provides
automatic notification to these client stations when the application changes.

This chapter describes how the distributed features of InTouch affect the runtime
environment.

Note  If WindowViewer has been configured to run as an NT service, NAD cannot be
used.

Contents
n Network Application Development (NAD)
n Configuring an InTouch Application for NAD
n Dynamic Resolution Conversion (DRC)
n Running WindowViewer as an NT Service
n Configuring System Privileges
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Network Application Development (NAD)
Network Application Development provides automatic notification of application
changes and automatic distribution of the updated applications to View nodes.

In the NAD architecture, a master copy of an application is maintained on a central
network location. Each View node loads the network application from this server and
copies it to a user-defined location. In the example below, the two View nodes both have
the master application registered from the Development node, but actually run it from
their own hard drives.

 
Network

View Node 1Development Node View Node 2

InTouch
App.

InTouch
App.

InTouch
App.

Process

When a View node copies and runs the master application, it automatically monitors for
changes in the master copy. When these changes occur, each View node has a user-
definable action that specifies the response of that node. This can range from ignoring
the flag to automatically shutting down and restarting the View node, which reloads the
master application.

Configuring an InTouch Application for NAD
Network Application Development or NAD is an architecture that combines the best of
the client-based and server-based architectures. NAD provides automatic notification of
application changes and automatic distribution of the updated applications to View
nodes. NAD can even be used to automatically distribute master/slave applications.

Note  You cannot use the NAD features if you are using WindowViewer as an NT
Service.
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Ø   To configure an application for NAD:

1. Start the InTouch program (INTOUCH.EXE). The InTouch Application Manager
dialog box appears:

 
2. Click the Node Properties tool or on the File menu, click Properties, or right-click

a blank area of the application display window, and then click Properties. The
Node Configuration dialog box appears with the App Development property page
active:

 

Note  The App Development property sheet provides several options that allow
you to specify how NAD will function. These settings are configured on each View
node, NOT ON THE DEVELOPMENT NODE. This allows unique
configurations for each View node.
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8 When you run WindowViewer as an NT service, it allows continuous operation
of WindowViewer through operating system log-ins, log-outs, for example,
operator shift changes. By selecting this option you also allow automatic start
up of InTouch following power failure or when the machine is turned off and
on. By doing this, you provide unmanned station startup of WindowViewer
without compromising NT operating system security. However, you cannot use
NAD features if you are using WindowViewer as an NT service.

4. Select Update local application when WindowViewer starts if you want to copy
the master application to the local working directory or View node on startup of
WindowViewer.

8 The initial copying of the master application may take longer than subsequent
updates.

5. In the Local working directory box, type the directory that you want
WindowViewer to copy the master application to.

8 If this is the development node, you can type a local directory path, such as
c:\InTouch\NAD. You can also type a networked remote UNC path, such as
\\node\share\path. This is convenient for file server based networks where
most file storage is kept in a central location. If this is a client node (runtime
only), it will likely use a local directory path. If you do not specify a directory,
WindowViewer automatically creates a local subdirectory named "NAD" in the
directory from which WindowViewer is launched.

It is recommended that you use a local directory whenever possible to prevent
network delays and failures from affecting the operation of WindowViewer.

Warning!  Do not use a "root" directory or a UNC pathname that points to a root
directory. The View node will recursively delete all files and subdirectories in the
specified destination application directory before copying the master application
directory. Therefore, never use the path of the master application directory or a
UNC to the master application directory.

This directory should be considered a temporary directory and no files should be
saved to it except those copied by NAD itself.

&  For more information on UNC paths, see your online InTouch User's Guide.

6. In the When Application Changes group, select the option for the action that you
want WindowViewer to take when the master application changes.

Automatically download Automatically shuts down WindowViewer on
changes and restart the View node, copies the updated master

application (if configured to do so), then
restarts WindowViewer on the View node.

Prompt user to Reload Causes an interactive message box to appear on
or ignore changes the View nodes notifying the operator that the

application has changed and asks if he wants to
restart WindowViewer.

If the operator selects Yes WindowViewer
shuts down on the View node and the updated
master application is copied from the
development node (if configured to do so), then
WindowViewer restarts.

If the operator selects no, it will behave exactly
as Ignore changes - do not reload.

Ignore changes - do not reload Causes the View node to ignore any changes
the development node made to the master
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application. Also used when customizing NAD
update functions.

&  For more information, see your online
InTouch User's Guide.

7. In the Polling Period (sec) box, type the number of seconds that WindowViewer
will wait before checking the master application for changes.

Note  Caution is advised when specifying this setting, a value too small will cause
WindowViewer to spend too much time checking for master application changes.
This can interfere with WindowViewer servicing the running application.

8. In the Number of retries box, type the number of attempts that will be made to
shutdown and restart WindowViewer when the master application changes.

8 This option is only valid if you have selected Automatically download
changes and restart.

9. Click OK.

The Application Copying Process
When the WindowViewer node copies an application, it makes every attempt to retain
the attributes (read-only, system, hidden, and so on.) of the master application during the
copy process. WindowViewer also copies all files and subdirectories of the master
application. The copy process does not copy the following files: *.WVW, *.LGH,
*.LOG, *.IDX, *.LOK, *.FSM, *.WBK, *.CBK, *.DBK, *.GBK, and *.NBK.

Note WindowViewer will recursively delete all files and subdirectories in the
destination application directory. This directory should be considered a temporary
directory (no files should be placed into it).
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Dynamic Resolution Conversion (DRC)
Dynamic Resolution Conversion (DRC) works with other distributed features to provide
independence from screen resolution restrictions. In a NAD architecture, an InTouch
application is created and maintained on a development node, and then copied to several
View nodes. DRC allows all of these nodes to view the application, even if they are
running at different screen resolutions.

DRC enables each View node to scale the application to a number of user-defined
options, including a custom resolution. This scaling takes place while WindowViewer
compiles the application, and does not require WindowMaker. Since each View node
can use a different DRC setting, each View node must have its own settings configured.

Ø   To configure an application for DRC:

1. Start the InTouch program (INTOUCH.EXE). The InTouch Application Manager
dialog box appears:

 
3. Click the Node Properties tool or on the File menu, click Properties. The Node

Configuration dialog box will appear.

8 To quickly access the dialog box, right-click a blank area of the application
display window, and then click Properties.

Note  When an application is selected in the Application Manager window,
selecting the Properties command on the File menu will display the Properties
dialog box for that application.

4. Click the Resolution tab:
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5. Select Allow WindowViewer to dynamically change resolution if you want

WindowViewer to locally scale the master application, based on the resolution
option you select. (The three resolution options are described below.)

8 If you do not select this option, WindowViewer will only run the application if
the node's screen resolution is identical to the screen resolution of the
application development node. If the resolutions are different, WindowViewer
prompts the operator to run WindowMaker to convert the application to the
node's resolution. Use caution when doing this if you have set up a UNC path
to the master application directory as this will only modify the original
application.

6. Select Use Application resolution if you want WindowViewer to run the
application at the resolution it was developed for and ignore the node's resolution.
For example, if the application was developed at 640x480 and the node's resolution
is 1024x768, WindowViewer will not dynamically scale the application. Instead,
the application will be displayed at 640x480.

7. Select Convert to screen video resolution if you want WindowViewer to run the
application at the node's resolution and ignore the resolution the application was
developed at. For example, if the node is running at 640x480 and the application
was developed at 1280x1024, WindowViewer will dynamically scale the
application (smaller) to fit the node's 640x480 display. (This will more than likely
be the most commonly used setting.)

8. Select Custom Resolution if you want WindowViewer to run the application at the
resolution you specified in the Pixel width (X) and Pixel height (Y) (must be
integer values) boxes. The application's resolution and the node's resolution are
both ignored. For example, if Pixel width (X) and Pixel height (Y) are set to 512
and 384, respectively, the application will dynamically be scaled to fit in a
512x384-pixel area on the node's display.

9. Click OK.
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Working with Multiple Monitor Systems
There are several advanced graphics adapter cards on the market today that allow you to
have more than one VGA monitor connected to your system at a time. These monitors
act in tandem, creating a virtual screen which can be very large. As an example, a
popular system connects four 17" monitors stacked as a cube: two on the bottom and
two on the top. Since each screen has a resolution of 800x600, the virtual screen created
is 1600x1200 pixels.

Dynamic Resolution Conversion (DRC) makes it easy to support these multi-monitor
systems. Simply select from the DRC resolution conversion options, and you can take
full advantage of all the virtual display or just a portion of it.

If an application is scaled to run on an even number of the monitors, a problem exists
when certain dialogs are displayed over the span of the monitors. One of these dialogs,
the Keypad, can cause particular problems as certain keys may not be accessible. To
solve the problem, InTouch provides several multi-monitor configuration options.

Ø To configure the multi-monitor settings on a node:

1. Using a suitable text editor, for example, Windows Notepad open the WIN.INI file
located in your Windows directory.

2. Locate the [InTouch] section and add the following parameters:

3. [InTouch]
MultiScreen=1 turns on multi-screen mode
MultiScreenWidth=640 width in pixels of a single screen
MultiScreenHeight=480 height in pixels of a single screen

For example, if your computer's resolution is 2560 x 1024 split on two horizontal
screens, enter the following:
[InTouch]
MultiScreen=1
MultiScreenWidth=1280
MultiScreenHeight=1024

Note  The above entries affect the numeric keypad and the QWERTY keyboard. Other
InTouch dialog boxes and option boxes are not affected.
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Running WindowViewer as an NT Service
Beginning with InTouch 7.0, you can create client-server configurations very easily.
You can configure a node that acts as a server node. This server node can then store the
Tagname Dictionary and historical log data, execute InTouch QuickScripts, provide an
alarming facility and I/O data. Any client node can then retrieve this information from
the server node and display graphics.

Running WindowViewer as an NT Service allows you to take advantage of all the
features that an NT Service provides. For example, continuous operation after the
operator logs off and automatic startup at system boot time without operator
intervention. This allows unmanned station startup of WindowViewer without
compromising NT operating system security.

Note  All NAD features are disabled when WindowViewer is installed as an NT
Service.

Ø   To configure WindowViewer as an NT service:

1. Start the InTouch program (INTOUCH.EXE). The InTouch Application Manager
dialog box appears:

 
2. Click the Node Properties tool or, on the File menu, click Properties. The Node

Configuration dialog box appears with the App Development property page
active:

8 To quickly access the dialog box, right-click a blank area of the Application
Manager's window, and then click Properties.

Note  When an application is selected in the Application Manager window,
selecting the Properties command on the File menu will display the Properties
dialog box for that application.
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3. Select the Start WindowViewer as an NT service option to cause WindowViewer

to automatically run as an NT service.

4. Click OK.

Notes

1)  If WindowViewer is configured as an NT service and subsequently started
directly (from its icon, the Windows startup menu and so on), there will be
approximately a 15 second delay before WindowViewer will display a window.
This delay is due to WindowViewer attempting to connect to the NT Service
Control Manager. Upon failing to connect to the Service Control Manager,
WindowViewer will display the following message box:

If you click Yes, WindowViewer is started as an application not an NT service. If
click No the command to start WindowViewer is canceled.

2)  If you stop WindowViewer from running as an NT service by clearing the Start
WindowViewer as an NT service option, WindowViewer is automatically
uninstalled as far as the Service Control Manager is concerned. However, it can be
run as an application
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Ø To reinstall it as an NT service

1. In the Windows Control Panel, double-click Services. The Service dialog box
appears:

 
2. Select Wonderware WindowViewer, and then click Start.

3. Click Close.

8 After you perform these steps, WindowViewer can be started as both an NT
service and as an application.
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Configuring System Privileges
During InTouch installation, you will be prompted to provide your user name and
password for your administrative account. This information is used to set the NT user
account information.  Services, such as Wonderware NetDDE Helper and Wonderware
WindowViewer, will use this information for logon and starting the appropriate services
during unattended start up.

 
1. In the Domain/Machine box, type the name of your system domain or the node

name.

2. In the User Name box, type your user identification.

3. In the Password box, type your system password.

4. In the Confirm Password box, retype you system password to verify it.

8 After installation, if you need to alter this information, run the Wonderware
Service User application (WWUSER.EXE) located in your installed directory, (for
example, \Program Files\FactorySuite\Common). When you run this utility, the
Wonderware Service User dialog box appears:

Enter the information as described above.
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Glossary of Terms

Accelerators .................................. Accelerators are used by the application in creating
a keyboard interface.  They are normally offered as
alternatives to using the menu for indicating
choices.  An accelerator is a keystroke that has
special meaning to the application and that can be
used to generate a command message.

Access............................................. The obtaining of data.  Locating desired data.

Active Application ........................ The application that created the window that
currently has the keyboard focus.  Applications do
not need to be the active application in order to
receive and process messages.  Applications are
notified by message whenever they are gaining or
losing the status of "the active application."  The
user normally determines the active application, but
applications can override this decision.

Alarm ............................................. A warning signal that is displayed or activated
whenever a critical deviation from normal
conditions occur.

Algorithm ...................................... A sequence of instructions which are mechanically
carried out to perform a procedure.

Analog............................................ Referring to the representation of numerical
quantities by the measurement of continuous
physical variables.

Application .................................... A program or group of programs used for a
particular kind of work, such as InTouch.

Assignment Operator ................... An operator used in an assignment statement that
causes the value on the right to be placed into the
variable on the left of the operator.
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Assignment Statement...................A programming language statement that gives a
value to a variable, such as in x = x + 1 or y = 6.

Asterisk ..........................................A symbol (*) used to represent a multiplication
operator in many programming languages.

b ......................................................An abbreviation for byte or baud.  Use bits when
referring to storage, or baud rate when referring to
communications.  Kb = 1000 bytes or baud
(technically 1K = 1024 bytes).  See Baud or Byte.

Background ...................................In multiprogramming, the environment in which low
priority programs are executed.  Also, the part of a
display screen not occupied with displayed
characters or graphics (foreground).

Backing Up ....................................The creation of a backup copy of a specified file or
files, transferring them from either a floppy disk or a
hard disk to another removable or fixed disk.

Baud Rate ......................................A unit for measuring data transmission speed.  One
baud is 1 bit per second.  Since a single character
requires approximately 8 bits to represent it, divide
the baud rate by 8 to calculate the characters per
second (cps) to be transmitted.  For example, 300
baud equals 37.5 cps, 1200 baud equals 150 cps,
2400 baud equals 300 cps.

Beta Testing ...................................Pretesting of hardware and software products with
selected "typical" users, to discover bugs before the
product is released to the general public.

Binary.............................................Pertaining to the number system with a radix of 2,
or to a characteristic or property involving a choice
or condition in which there are exactly two
possibilities.

Binary Code ...................................A coding system in which the encoding of any data
is done through the use of bits--that is, 0 or 1.

Binary Coded Decimal (BCD) ......A computer coding system in which each decimal
digit is represented by a group of four binary 1s and
0s.
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BIOS .............................................. An acronym for Basic Input/Output System.  In
some operating systems, the part of the program that
customizes it to a specific computer.

Bit................................................... A binary digit; a digit (1 or 0) in the representation
of a number in binary notation.  The smallest unit of
information recognized by a computer and its
associated equipment.  Several bits make up a byte,
or a computed word.

Bitmap ........................................... A memory image of a portion of a display device
surface.  In Windows, a bitmap is actually a data
structure containing a pointer to this memory image,
plus information about the display device.  The
amount of memory required for a bitmap is device-
specific, being dependent upon the color capabilities
and pixel resolution of the device in question.

Boot ................................................ To start or restart a computer system by reading
instructions from a storage device into the
computer's memory.  It involves loading part of the
operating system into the computer's main memory.
If the computer is already turned on, it's a "warm
boot;" if not, it's a "cold boot."

Border............................................ The line surrounding the current active window.  A
window can be resized by dragging on the border
when the two-header arrow is present.

Buffer............................................. An area of storage used to temporarily hold data
being transferred from one device to another.  Used
to compensate for the different rates at which
hardware devices process data; for example, a
buffer would be used to hold data waiting to print,
in order to free the CPU for other tasks, since it
processes data at a much faster rate.

Bus ................................................. A channel or path for transferring data.

Byte ................................................ A grouping of adjacent binary digits operated on by
the computer as a unit.  The most common size byte
contains 8 binary digits.

Clipboard ...................................... A storage area for holding data (text, bitmap,
graphic object, etc.) which is being copied or moved
to another application or window.
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Command.......................................A word or phrase, usually found in a menu, that
carries out an action.

Command Button ..........................A round-cornered rectangle with a label on it that
describes an action, such as OK, Cancel or Close.
When chosen, the command button carries out the
action.

Command Key ...............................Any keyboard key used to perform separate
functions.

Command Line ..............................The string of arguments that follow any MS-DOS
command, including the command to initiate an
application program.  The arguments in the
command line are passed to the MS-DOS function
or the program at startup time.

Computer Graphics.......................A general term meaning the appearance of pictures
or diagrams, as distinct from letters and numbers, on
the display screen or hard-copy output device.

Concatenate ...................................To link together or join two or more character
strings into a single character string, or to join one
line of a display with the succeeding link.

CONFIG.SYS ................................An ASCII text file that MS-DOS processes when
the system is turned on or restarted.  It allows the
user to configure certain aspects of the operating
system, such as the number of internal disk buffers
allocated, the number of files that can be open at
one time, etc.
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Control Menu................................ Usually there are two Control menus for each
windows application.  One appears in the upper-left
corner of the application window and is represented
by a box containing a Spacebar icon.  This is the
application Control menu.  The other appears in the
left corner of the window's title bar of the active file
and is represented by a box containing a hyphen
icon.  This is the file Control menu.  The Control
menu commands move, shrink, expand, close and
change the size of windows.

The application Control menu will close the
application and all of its open files.  The file Control
menu closes only the active file; not the application.
(InTouch does not have a file Control menu.)  Icons
and some dialog boxes also have a Control menu.
To display the application Control menu, press <Alt
+ Spacebar>.  To display the file Control menu,
press <Alt + Hyphen>. Either Control menu can be
displayed by pointing to its respective box pressing
the mouse button, and dragging to the desired
command.

Control Menu Box ........................ There are usually two Control menu boxes.  One is
located in the upper-left corner of the window
(usually represented by a Spacebar). The commands
in this menu box controls the entire application and
all open files.  The second Control menu box is
located at the left edge of a window's title bar.  The
command in this menu box control the active file
only.  Click on either box to view it's menu.

Crop ............................................... In computer graphics, to cut off some part of an
image.

CSV ................................................ Comma Separated Variable is the format used by
the Clipboard for transfer of columns of text and
numerical data between applications.  A CSV data
item is like text with each variable separated by
commas.  Although Microsoft Excel is probably the
principle creator of CSV clipboard data, many DOS
applications support this format.

Current File................................... The file that is running in the application.
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Database.........................................A collection of logically related records or files.  A
database consolidates many records into a common
pool of data records which serves as a single central
file.

Default............................................An option, command, or device that is automatically
selected or chosen by the system.  For example, one
of the command buttons in a dialog box is already
selected when the dialog box is opened.  This
indicates that it is the default value and will be
chosen automatically if the <Enter> key is pressed.
Default values are overridden by selecting another
appropriate option, command, or device.

Device Driver .................................A program that controls how the computer interacts
with a devices such as a printer, monitor, or mouse.
A device driver enables the use of devices with the
computer.

Description Box .............................The Description Box shows a description of the
current object, and also the time it was entered in
the current Scrapbook+ file.  A description may be
given for each page in each Scrapbook+ file.

Directory ........................................A structure for organizing files into convenient
groups.  A directory is like an address showing
where files are located.  A directory can contain
files, or sub directories of files.

Discrete Value................................A variable which only has two states:  '1' (True, On)
or '0' (False, Off).

Disk Operating System .................(DOS) An operating system in which the operating
system programs are stored on magnetic disks.
Typically, it keeps track of files, saves and retrieves
files, allocates storage space, and manages other
control functions associated with disk storage.

Display............................................The physical representation of data on the screen.

Dithered .........................................Intermingled dots of various colors which produce
what appears to be a new color.
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Document....................................... A unit of printer output that must be printed
contiguously; that is, no other output may be
interspersed within a document.  A document, then,
is analogous to a report.  The application must
specify the start and end of each document.

Drive .............................................. A letter in the range A-Z, followed by a colon (:),
indicating a logical disk drive.

Dynamic Data Exchange .............. DDE is the passage of data between applications,
accomplished without user involvement or
monitoring.  In the Windows environment, DDE is
achieved through a set of message types,
recommended procedures (protocols) for processing
these message types, and some newly defined data
types.  By following the protocols, applications that
were written independently of each other can pass
data between themselves without involvement on
the part of the user, e.g. InTouch and Excel.

ENTER Key .................................. The key on the keyboard which executes a statement
or command.  Same as RETURN key on some
keyboards.

Expression ..................................... A general term for numerals, numerals with signs of
operation, variables and combinations of these: 6,
3+6, n+10 are all expressions.

Extend............................................ To select more than one item in a window.  To
extend a selection, hold down the <Shift> key until
everything is selected.

Extension ....................................... The period and three letters at the end of a filename.
An extension identifies what kind of information a
file contains.  For example, the extensions .EXE,
.COM, and .BAT indicate that a file contains an
application.

File ................................................. A mechanism for holding and storing information
on a hard disk or diskette for later use.  File also
may refer to any document or database created by
the user, such as a word processing document,
spreadsheet, etc.  Each file appears in its own
window and in most cases, the name of the file will
appear in the title bar at the top of the window.
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Filename .........................................Filenames consist of a base name containing no
more than eight characters and a three-character
extension.  For example, INTOUCH.EXE.

Format............................................To prepare a disk so it can hold information.
Formatting a disk erases any previously stored data.
Format is the term used for an object rendition.  In
most Windows applications, available formats
include Text, Bit map, etc.

Graphics Object ............................A visually oriented object, such as a scroll bar, bit
map or icon that is used in the presentation of the
visual interface.  Graphic objects can be created by
either the application or by Windows for use by the
application.

Help ................................................Online instructions that explain how to use a
Windows application.  The Help menu displays
specific Help topics.  Pressing <F1> displays a list
of Help topics.

Highlight ........................................Indicates that the object is selected and will be
affected by the next action or command.  A
highlighted object appears in reverse video.  A
selected icon is outlined in white and displays the
application's name.

Icon .................................................A small graphic symbol representing an application
running in memory.  Every application, including
Help, the Clipboard and the Control Panel has its
own icon.  When an application is minimized into
an icon, the application is still running in memory
but is not taking up space in the screen work area.
Icons can be expanded into a window when it
becomes necessary to use the application again.

Inactive...........................................A window or icon that is not selected.  See Select.

Insertion Point ...............................The place where text will be inserted when the user
types.  The insertion point usually appears as a
flashing vertical line (the cursor) and can appear in
the workspace or within a dialog box.  The text
typed appears to the left of the insertion point,
which is pushed to the right as text is entered.
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Integer............................................ Any member of the set consisting of the positive and
negative whole numbers and zero.  Examples: -59,
-3, 0.

I/O .................................................. An abbreviation for INPUT/OUTPUT.

Key Accelerator ............................ A special keyboard sequence that executes menu
commands, e.g., Ctrl + A.  See Accelerators.

List Box.......................................... A box within a dialog box listing all available
choices for a command.  For example, a list of
filenames on a disk.  Usually an item is selected
from the list box, then "OK" is chosen.  If there are
more choices than can fit in the list box, it will have
vertical scroll bars.  Selecting the down arrow next
to the first item in the list will display the rest of the
list box.

Macro............................................. A single, symbolic programming-language
statement that when translated results in a series of
machine-language statements.

Maximize ....................................... To make a window or icon fill the entire screen.  To
maximize a window, choose the Control/Maximize
command, or click on the Maximize box in the
upper right corner of the window.  See also
Minimize and Restore.

Maximize Box................................ A box containing an upward-pointing arrow in the
upper right corner of the window.  Mouse users can
click on the Maximize box to enlarge a window to
its maximum size.  The Maximize box changes to
the Restore box when the window appears at its
maximum size.  See Maximize.

MB ................................................. An abbreviation for megabyte.  One million bytes.
1000KB.

Megabyte ....................................... 1,048,576 bytes or 1024 kilobytes, actually; or
roughly one million bytes or one thousand kilobytes.
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Menu ..............................................Menus are group listings of available Windows and
application commands.  Menu titles appear in the
menu bar at the top of the window.  A command is
chosen by displaying the menu, then choosing the
desired command.

Menu Bar .......................................The horizontal bar that lists the names of an
application's menus.  The menu bar appears below
the title bar of a window  Each Window's
application has a menu bar that is distinct for that
application, although some menus (and commands)
are common to many of these applications.

Message Box ..................................A special dialog box through which an application
displays error messages or other important
information.  Message boxes alert the user when an
error occurs or when the application needs
information to complete an action or command.

Millisecond.....................................One thousandth of a second, abbreviated ms or
msec.

Minimize ........................................To turn a window into an icon.  To minimize a
window, choose the Control/Minimize command, or
click on the Minimize box in the upper right corner
of the window.  See Maximize and Restore.

Minimize Box.................................A box containing a downward-pointing arrow in the
upper right corner of the window.  Mouse users
click on the Minimize box to shrink the window to
an icon.  See Minimize.

Mirroring .......................................The display or creation of graphics that portray an
image in exactly the reverse orientation it originally
had, e.g., flipping the graphic on its x- or y-axis.

Mode...............................................A method or condition of operation.

Modulo ...........................................A mathematical function that yields the remainder
of division.  A number x evaluated modulo n gives
the integer remainder of x/n.  For example, 200
modulo 47 equals the remainder of 200/47, or 12.
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MS/DOS......................................... An abbreviation for MICROSOFT DISK
OPERATING SYSTEM, the standard operating
system used by the IBM Personal Computer and
compatible computers.  Developed by Microsoft,
Inc.

Multitasking .................................. The ability of a computer to perform two or more
functions (tasks) simultaneously.

Object ............................................ A set of data.  Objects come in several formats; bit
map images, text, Real Time and Historical trend
graphs, etc.

Off-line........................................... Pertaining to equipment or devices not in direct
communication with the central processing unit of a
computer.  Equipment not connected to the
computer.

Operand......................................... A quantity or data item that is operated upon.

Operating System ......................... Software that controls the execution of computer
programs and that may provide scheduling,
debugging, input/output control, storage assignment,
etc.  Abbreviated OS.

Operator ........................................ In the description of a process, that which indicates
the action to be performed on operands.

Option Button ............................... A small round button appearing in a dialog box  An
option button is selected to set the option, but within
a group of related option buttons, only one can be
selected.  An option button has a black dot when it
is selected and is blank when it is not selected.

Option Button Group ................... A group of related options in a dialog box.  Only
one option button in a group can be selected at any
one time.

Page................................................ A page is a block of information that is selected and
stored in a file.  For example, a paragraph of text
from Microsoft Word may be a page and a chart
from Microsoft Excel may be another.  Pages may
be held in a variety of formats in the same file.
Pages are numbered as they are placed into the file.
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Page Slider .....................................Appears just to the right of the Clipboard icon in the
Scrapbook+ application.  It tells how many pages of
objects are in the current Scrapbook+ file.  It is also
used to display particular pages in the file for
viewing and manipulation.  The number of the
current page will be shown in the Page Slider.  A
new page can be selected by dragging the Page
Slider with the mouse to the number of the page to
view.

Palette.............................................The set of available colors in a computer graphics
system.

Parity..............................................An extra bit added to a byte, character, or word to
ensure that there is always either an even number or
an odd number of bits, according to the logic of the
system.  If, through a hardware failure, a bit should
be lost in transmission, its loss can be detected by
checking the parity.  The same bit pattern remains as
long as the contents of the byte, character or work
remain unchanged.

Paste ...............................................To insert something into a document or file from the
Clipboard.  Some applications (including InTouch)
may have a Paste command that performs this task.
If using some other standard application that runs in
a window, Windows adds the Paste command to the
Control menu.

Path ................................................The hierarchy of files through which control passes
to find a particular file.  Designates one or more
disk drives and/or directory paths to be searched
sequentially for a program or batch file if the file
cannot be found in the current or specified drive and
directory.  The drives and/or directory paths are
searched in the order they appear in the Path .

Pathname .......................................A description of the location of a directory or file
within the system.  The pathname consists of the
drive letter, a colon (:), followed by directory and
subdirectory names, followed by a filename.  Each
name is separated from the previous one by a
backslash (\).  If not specified, a default drive and
directory are used.
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Pixel................................................ A picture cell.  Shortened version of "picture
element."  The visual display screen is divided into
rows and columns of tiny dots, squares or cells, each
of which is a pixel.  The smallest unit on the display
screen grid that can be stored or displayed.  A
computed picture is typically composed of a
rectangular array of pixels.  The resolution of a
picture is expressed by the number of pixels in the
display, e.g., a picture with 560 x 720 pixels is
much sharper than a picture with 275 x 400 pixels.

Poke................................................ An instruction used to place a value (poke) into a
specific location in the computer's storage.

Polling ............................................ A communications control method used by some
computer/terminal systems whereby a computer asks
many devices attached to a common transmission
medium, in turn, whether they have information to
send.

Port ................................................ That portion of a computer through which a
peripheral device may communicate.  A connection
between the CPU and a peripheral device.

Precedence..................................... Rules that state which operators should be executed
first in an expression.

Process Control ............................. The use of the computer to control industrial
processes such as oil refining and steel production.

Process Control Computer........... A computer used in a process control system,
generally limited in instruction capacity, word
length and accuracy.  Designed for continuous
operation in non-air conditioned facilities.

Processing...................................... The application that currently has control of the
processor.  An application is given control of the
processor upon receipt of a message.  It retains
control of the processor until the message is
processed.

Protocol ......................................... Set of rules or conventions governing the exchange
of information between computer systems or
applications.
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Pull-down Menu ............................A menu that can be displayed by moving the mouse
pointer to a title, then pressing the mouse button.

Queue .............................................A group of items waiting to be acted upon by the
computer.  The arrangement of items determines the
processing priority.  For example, documents
waiting to be printed.

Register ..........................................A high-speed device used in a central processing
unit for temporary storage of small amounts of data
or intermittent results during processing.

Restore ...........................................Icons can be restored to full-sized windows by
double-clicking on them.  To restore a window,
choose the Restore command from the Control
menu, or click on the Restore box in the upper right
corner of the window.  See Maximize and
Minimize.

Restore Box....................................A box containing two arrows (one upward and one
downward-pointing) in the upper right corner of the
window.  See Restore.

Run .................................................To start an application.  The Run command lets you
specify parameters for the application.  An
application can also be run by double-clicking on its
name or icon.

Running..........................................An application that is "running" is an application
that is in the system as a task, can receive messages,
and is (normally) known to the user.  From initiation
to termination, an application is always running, but
it is not always processing.  See Processing.

Runtime..........................................The time during which data is fetched by the control
unit and actual processing is performed in the
arithmetic-logic unit.  Also, the time during which a
program is executing.

Scaling ............................................The process of changing the size of an image.

Scroll ..............................................To move data or text up and down, or left and right
to view parts of the file that cannot fit on the screen.

Scroll Bars......................................The bars that appear at the right side or bottom of a
window.  Use the scroll bars to move through a
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window that contains more information than can be
shown on one screen.  The scroll bar at the right
side of a window scrolls vertically.  The scroll bar at
the bottom of a window scrolls horizontally.

Scroll Box ...................................... The small white box in the scroll bar.  The scroll
box reflects the position of the information within
the window in relation to the total contents of the
file.  For example, if the scroll box is in the middle
of the scroll bar, then the text or data in the window
is in the middle of the file.  The mouse can be used
to scroll by dragging the scroll box in the scroll bar.
See Scroll Bars.

Serial Port ..................................... An input/output port in a computer through which
data is transmitted and received one bit at a time.  In
most cases, in personal computers, serial data is
passed through an RS232C serial interface port.

Spreadsheet ................................... A program that arranges data and formulas in a
matrix of cells, e.g., Excel.

Statement....................................... An expression of instruction in a computer
language.

String ............................................. A connected sequence of characters or bits treated
as a single data item.

Subdirectory.................................. Subdirectories are located within Directories.  They
are a structure for organizing files into convenient
groups.  A subdirectory is like an address showing
where files are located.

Syntax ............................................ The rules governing the structure of a language and
its expressions.

Task................................................ A task is an executing application.  Task is a
synonym for "process".

Tagname ........................................ The name assigned to a variable in the database.

Text Box......................................... A box where information needed to carry out a
command is typed.  A text box usually appears in a
dialog box.
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Tiled Window ................................A tiled window is a window whose size, shape, and
location on the screen is determined by Windows.
Tiled windows are the only style of window that
cannot overlap other windows, can be placed into
the icon area and can have menus.  Each application
normally creates just one tiled window.  All
additional windows created by an application are
normally cascading or popup windows.

Time slice .......................................A unit of time.

Title Bar .........................................The bar across the top of each window that contains
the name of the application and the document or file
being used by that application.  (In InTouch an
option exists to eliminate the Title bar.)  Title bars
are also used to move a window on the screen by
grabbing it while dragging the mouse.

Touch-sensitive screen ..................A display screen on which the user can enter
commands by pressing designated areas with a
finger or other object.

Viewing Area .................................The viewing area (also called "Workspace") in
Windows applications displays one page of a file.
See Workspace.

Window ..........................................A rectangular area on the screen in which an
application is viewed and worked.  Multiple
windows can be open on the screen at one time
which can be sized and moved independently.

Windows.........................................An operating environment developed by Microsoft.

Windows Application....................An application that is designed especially for the
Microsoft Windows operating environment and that
uses all Windows features such as menus, scroll
bars, and icons.
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Workspace..................................... The area of an application window that displays the
application itself and all other open windows.

x-axis .............................................. On a coordinate plane, the horizontal axis.

y-axis .............................................. On a coordinate plane, the vertical axis.
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